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§ 1.2 ICD23ZHFirats i i

YR (MPLAB IDE V6. 62)
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dsPIC30F2010
dsPIC30F2011x*
dsPIC30F2012x*
dsPIC30F3012*
dsPIC30F3013*
dsPIC30F3014x*
dsPIC30F4011
dsPIC30F4012
dsPIC30F4013*
dsPIC30F5011
dsPIC30F5013
dsPIC30F6010
dsPIC30F6011
dsPIC30F6012
dsPIC30F6013
dsPIC30F6014
PIC12F629!
PIC12F635!
PIC12F675!
PIC12F683
PIC16F627A!
PIC16F628A!
PIC16F630!
PIC16F636!
PIC16F639%
PIC16F648A!
PIC16F676!
PIC16F684!
PIC16F688!
PIC16F716!
PIC16F737

dsPIC30F2010

dsPIC30F2011x*
dsPIC30F2012x*
dsPIC30F3012x*

SRR T

PIC16F747 PIC18F2439
PIC16F767 PIC18F2455%
PIC16F777 PIC18F248
PIC16F818 PIC18F2510%
PIC16F819 PIC18F2515%
PIC16F87 PIC18F252
PIC16F870 PIC18F2520%
PIC16F871 PIC18F2525%
PIC16F872 PIC18F2539
PIC16F873 PIC18F2550%
PIC16F873A PIC18F258
PIC16F874 PIC18F2585%
PIC16F874A PIC18F2610%
PIC16F876 PIC18F2620%
PIC16F876A PIC18F2680%
PIC16F877 PIC18F2681*
PIC16F877A PIC18F4220
PIC16F88 PIC18F4320
PIC16F916% PIC18F4331
PIC16F917% PIC18F4410%
PIC18C601 PIC18F442
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PIC18F1220 PIC18F4431
PIC18F1320 PIC18F4439
PIC18F2220 PIC18F4455%
PIC18F2320 PIC18F448
PIC18F2331 PIC18F4510%
PIC18F2410% PIC18F4515%
PIC18F242 PIC18F452
PIC18F2420% PIC18F4520%
PIC18F2431 PIC18F4525%
PIC16F648A PIC18F2320
PIC16F676 PIC18F2331
PIC16F684 PIC18F2410%
PIC16F688 PIC18F242
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PIC18F6390*
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PIC18F6525
PIC18F6585
PIC18F6620
PIC18F6621
PIC18F6680
PIC18F6720
PIC18F8310%
PIC18F8390%
PIC18F8410%
PIC18F8490*
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PIC18F8525
PIC18F8585
PIC18F8620
PIC18F8621
PIC18F8680
PIC18F8720

PIC18F4520%
PIC18F4525%
PIC18F4539

PIC18F4550%
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dsPIC30F4012x* PIC16F74x* PIC18F2455% PIC18F4620
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PICI6F627A PIC18C601 PIC18F4455% PIC18F8680
PIC16F628A PIC18C801 PIC18F448 PIC18F8720
PIC16F630 PIC18F1220 PIC18F4510%

PIC16F636 PIC18F1320 PIC18F4515%

PIC16F639* PIC18F2220 PIC18F452
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FHHI-TECH PICC ME16 Cifigmitas, WMAMTEEAE “HI-TECH PICC Suite” KIZHERFT 4.
B ROk P AR RGO PRIEAT,  wln] DURR) 285 5¢

= 245 F ICD24E R AR 2R

§ 3. I FiE iz

EAE ) IE A D IR

1) FIRS2324k1%4:PCHITCD2 EHL;

2) 6 IR B 1CD2 F WA B3k

3) W FLELAR B bR b

4) HHINICD2IF) B YR 15 i $ _ TCD2 L Y sl 2 FH A L

s S AR RSk, AR B TR, IR AP ER2) AI3) NG
A 6K TCD2 B MR A AR Bl 1 G D s 7 LS —B5 ) “ e S
B OETD .
§ 3. 2% EICD2
§3.2.1 s

B, HPREEFRRS RS CORERFNS LR R AR, SdiE
KL Configure—>Select Device, FEIERELS A T4 AR F7 52 5 LR $8 75 B 1) o0y Y
o WE6HTR.

Select Devioe x|

Davice:
friciesariy -
M chip Programmer Tood Support
@ PICSTART Fiuz @ MPLARICD 3

{3 FROMATE Il @ FICkR1
) WFLAE FM3
W oz i D2 b gar Tood Supgort
i} WPLAE SIW 3 MPLABICED 2
WPLAS ICE 2000 MPLAS ICE 2000
@ PCMEHYD @0 Wodule

| 'Ii_ﬁ I Canced | Help |
Ke: A

EEETHNORZ G, HPBaEiEses A5 % 10/ “Microchip Programmer Tool
Support” HEHF FMicrochipheE T HXZ O I SZFfE M £E “Microchip Debugger Tool
Support” HEHE FMicrochipid T HXZ N S RGO, o

D) 4 pi3omiz TR Harbe A SR s frs

2) SRR TR DISZRE Y ArS s

3) AR NZ T HE HEO Y ares i i SRR b A M EOIR A

TEIERES e S 2 Ja fidhy “OK” #fiik.

§3.2.2 W T HiEIm

§3.2.2.1 WP T HAEM

W R kB ICD2AF A K T, A 75 ZEAEMPLAB IDEFR AT & . midy TR )
Debugger—>Select Tool, i%E#HENMPLAB ICD2.
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H1-T-MPLAB IDEBRIA HI@E 1R 77 2o usb 3% 11, %1 HARS232482 LI ICD2ANRE U], BRIt 2
I N AR

Connecting to MPLAB ICD 2

ICD0019: Failed to open communications: Non—existent port

ICD0021: Unable to connect with MPLAB ICD 2ICD0021: Unable to connect with MPLAB ICD

2

MPLAB ICD 2 Ready

R DRECE R U6 i R W W S R -

§3222 wEHEfE A

il & 32 ) Debugger->Settings « & 4t 5 HH — 4~ ICD Debugger & 1, % #f
“Communication” . £ “Com Port” #:HLEFAANIICOME, SRJ57E “Baud Rate” 2 HLIEFE
AN A PR TR o« WESERUG T N N R

Fower I Frozram I Yersions I Warnings
Status Communi cation | Limitations
Ciomn Part Baud R ate

[cur«n =1 [f19200 7]

COM1
COMZ
COk4
IISB
BT B A 72

SR, TCD2 A R G HMPLAB IDEJT T #AFE RGEIAS IH, I I R GEH 23277 “ ICDWarn0030:
ICD2 is about to download a new operating system.. . Downloading Operating System” . X & RFAE
LA A A E R S, H P T AR — BN ) DU 58 O A
HE: A IKMEHICD2R, RESHFIRLUFE A
ICDWarn0034: Please ensure that your system's serial FIFO buffers are disabled.

PERVRELRGAR TSR DI FIFOZE M X G, Tk

FIARE S BRI EREE Y, LRSI AIEHE, AT R SR, R R R
w7 IR A B HE, Al o, ARG ComREs 7, kR <R, I
TG DONEHE, P Al o D E S P g R, MmO B EHE, PRI Al
MIFIFOZZ X F i 2) L4, FEEOF A ST

MEFEAE RS N RGEZ G, RGN SR EICD2IE RS DL, WIRHE/R “Target Device
#0xx found” A —VIER; WHHER “ICDWarn0020:Invaild target device id . . 7 HB-A 14 A
WV E U6 A E AR Do

FE: HFMPLAB—IDE®RIAKHu s bHRAN, EHERMHEI CD 2 WY TEEHE
E= TRz W

§ 3.2.2.3 WHE ik

7EICD Debugger i H L EF: “Program” K EAHN M g FEiL . /£ “Select Memories” £~
H R AN LT jr4) B4, tndn e “ID” ardl b2, fEgmFEny a5 AN H 1D,
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MFLAB LD ¥ Setiigs 2=l

Etniua I Commsmnicakion | Limatatiena |
Feowar Fragrae Vareioas | Tarrioge

0 alew ICD 2 1 sahit wervion: aid | arvgis
¥ [Warasly selact meronar and rang
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- e——
' Corfipanior [T Eisze o baforw Proguan

[~ EEPHCM
I
[T Eeerie
m“m Lt oo
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Ered |I'b:|'| E |h-'l

|-.|._-|,._Ir.|.. ..-.-:'-,..-;_I Hioes I
[(mE ] ®m | mfw | W |

Kl 8 e i 1L I
FH P IE T DLV B g R R IR g A A 2 B bk, 7F “Program Memory Address”  (FEJ747
ittt # 5 BRCE AN PRI 7R B MR IR 7T AR IL0x10, 17 45 AR Hb R ) 75
BT TCD2 ) 2 FE Sk 0 W 5 R PP AR T B 25 5ANTE R ) 25 0] o 4 PR B AR R 45 R M ik DA

B I
BB SERE ST N7 N SR R BEE
§3.2.2.4 HJFE

WA B BARBROA T R, ISOR 5 Sk 0 HICD24 I H i) 77 28, & “Power
target circuit from MPLAB ICD2” . {EICD Debuggerfd I FLiEHF “Power” SRk B AHNIEI, Wl
K9P o

HE: HFH I CD 2 HIE, HARKNERELHEF N2 0 0ma, FFHEEAN00ma .

MPLAT ICD 2 Settings 3=l
Statne | Comarri oatien | Limitatisne |
Eomwar | T i | Versians | W B REs
Tasgel Vid .
Tanget Vip 000 L

HPLAS ICD 2 'vpp I nen

‘Wahper s ppdsied on connschion, requesis o
upaiate, s poser eiEng changes

™ Poser bnget cirout from MPLAE ICD 2 50 Wdd]

K 9 B HL Y
WM st B aA IR T, ATFE R EVORER I 238 4 “Power target circuit
from MPLAB ICD2” (MICD2tH) 1y i )2 F= 4
ffiFl “Update” 28 a7 LLLE ] 7 %008 H AT H AR _EAIVdd. Vpp A K ENIER GRS HLR S
o
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BEESERE A R “ N SR R A B

§3225 THER
FH P& W] AZEICD Debugger i T 1 i 21 8 4% JL Al AH 5 145 8 -
“Status” FLH: BRMEDIRA, AEMEH el LIBET B

“Warning” £ H: BE5EE, HP T DIEX M H B S 4T A G 505 B
“Limitation” F:H: MIXHEH 0] BL T f# BICD2 1 —LL4f I B 5
“Versions” F2H: FRAME;

ICD Debugger i LI ITA T H W& e UG, R sid “ffie” BHwRE, WRSKSMR
T AT BEE s W A THICD Debuggertid A FT I “X 7 KB & &, IBATTE A “NAH”
[PV B AN LRAT
§ 3.2.3 W HE I ICONFIGT

BEAE W R R IE W M T AR M ik 77 B E A N 1 CONFIG &, Uil £ S8 1
Configure->Configuration BitsK 3T AW (1% & .

RGUKL i —A “Configuration Bits” % 1, WK 107w

(W configueationsts =101 x]
Addreas |walue [ cavegory | satring |
2007 F738 CacEillaToE xT

Wmitchdog Time=r B
Power Up Timsr Off
Brompn Cur DEpscse O

Lo Votage Prooes (ETE RN |
Fla=zk Progemm Wrice Write Frotecclon OFF

hats EE Pesd Protect Off

Code Froteot Of s

P10 Configurationi & & I
sl “Setting” F1) HL T RAH R I Z G R HIL— AN FHSE, P n] LAfEX AN S
HRIE PN R WCE o T AR HIICD24E A AR 1 s, 75 25K H] “ Low Voltage Program”
(IR gt &5, LALOCH] “Code Protect”  (fUB LR
F P IRTC B T AR S B Dok £, I8 v ml e o IE & AR T BUCD2 H
HIRTER o
§324 W HIEF LA
WA P HEAAHCE S kmfE, 2H P eHEREES TRREE.
fili ESEH I Project->Set Language Tool Locations.. K B 155 THEKE. RGN
“Set Language Tool Locations” (B LHAE) X IHHEREPANE S TH, Aph
PR EHITECH PICCH 1 &% . AEAH N HTE 5 1T 1B “Executables” (R hAT3CHF) W
1R,
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%Set Langueage Tool Locsbions _ﬂ

~ Fegsieed Took:

LA

++ CC5 C Compile
++ CCS C Compder lor FIC1 2414416118
=+ HI-TECH PICC Tioolsuis

-+ Eveptables

FICC Compder [pioo sws]
FICC Linkes [pico ss]
+- Di=faull Seanch Paths & Disscloses
HI-TECH PICC-18 Tookus
- LAR FICTE
% &R Sytams Midsangs =l

[E—

=

Location
|I:-'J-IT PICABINAPICE EXE Biowse..

Hep | [ ok ] Coed | s |

K11 W EE S LTRSS
EARGIR, FRATE “PICC Assembler” . “PICC Complier” 1 “PICC Linker” #B & $5 1
JC:\HT-PIC\bin\picc.exe, iXJEFkMIPC_EAHITECH PICCiiFasikit, FH /A% SE bR 205
TR E .
W P AT i 5 AT A, AT DU B IR I, A BRA R

§33 v TRAmH

§3.31 &Il
TEXTYSFE P BT AR 2 U B ST 2, — N H , IXAEMPLAB IDE R 485 REEAH I 11 34
IEPSS Nt

i R Project->New, KENHIIIH . £ RFHH KT “New Project”  GHrIiH)
T I “Project Name” (I H A4 FK) A2 HLHDE S AN I H 44, 213030 H 1) 44 Fr R
PPN IR —E RJEMEH “Browse” (R FRHIKRIEBIEFEF IAERI A, SUUH %
A WP S AR — A H B CH BRGS0 , DUE T, 7ET A sE 5%
G s “OK” B, X REMAEIIEFER AR AN AN SN . mep U,
§ 3.3.2450 CIMERD 1Y s 3CAf

B P oRT LA F RSO AR H B, H RS R I EE R — “*mew” 1)
I, fE “*mep” MWW FEIANDS, aliE “Source Files”  (YiFE)T) « “Head Files” (3k
) . “Object Files”  (HFRICAE) K “Library Files” PESCHE. Wil 127k
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i Untitled Workspati

K12 WiH %

FH P ] AT B A R IR 4y ST “ Add Files”  GARSINSCAHR) Sk InSCt, X Ses Rl
BFRZ R RSO, T A RO AR R (o [RIRE R Y T AR 6 2 1) SCPE AT A B e o
SRMERSCAE,  FEMER T R SCEZ BTG R % BN LS DA FHZIH R AR

§ 3.4 1§ HICD2i AT Ik
§ 3413k £ A IR

65T R T AT B N I E B A 2 e, P i nT DU 7.
§34.1.1 %

18 33 H1 i Debugger->Connect, BEEHATH T HAZ ERREERIbRRES: . BN IIZ )G
1E “Output” 7 H ) “MPLABICD2” {5 & 71 HUBF 2R “ Target Device **** found, revision=**",
W3R, WHHR R “ICDWarn0020:Invaild target device id . . 7 FIS 4 T K6 £ H Y5 138 DL A 6.0
HL 2 R AT 0L

=10l x]
Puild | Vermion Comtyol | Find im Filsx HFLAS ICO 2
Connectirg %o IFLAR TCD 2
ICH00] 0y Pailed to opssn commaraostions) Horesxistest port
ICDO02]): Urable ta corewct with NFLAE ICD 2
IC0002); Unsble to conesct with MFLAE ICD 2
IFLAA ICD 2 Ky
Copnaotaeg o BELAR ICT 2
.« < Carmectad
Catting Vid soarce o EPLAR ICD 2
Target Device FICLGFETTA fouwed, réviiian = BI
+» - Rmadirg ICD Froduct ID

wning ICO Self Test
.- -Pazzed
Lab IS 2 Ready

KI13 3= St A E i 1
§3.4.1.2 9wk
B MR P B AT OV, DM AR B N R IR SO . At 228 HL T Project->Build ALK S 3
FBATIH, sg T A E A bR
G PE S K AE “Output” % ) “Build” TR R WERGIERIL TR, WPKASAE &
PRI B hex SO, IXFEEARRARSEIAT F—22 1. H P f B Z U R UER P 2 )
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T, EEGIERNH R R,

§34.13%ifE (KE5)

) “Output” & AH “Build” TR NI )G, daidid B4 w7 AR hex ST
BEI P T B T A B “gfe” PRBE bt B AR R BT, ERFERT 5 e R
[FJCONFIG ¥ & LA S g it X 3 2

WERGRFE L RE T B “Config X A58 M FI4E7R, 1R Er O A IMCLR B HL % o W R AR
FHI A H e B s Eh s X, T BB T 1% 2%

§ 3.4.21247 MR

eGP I 2 5 FH P v OEA TR T« ICD24 4t 7 2 Fhig AT LI TFBr . 8 1s X
YEIEAT AR T BT LR (AR FE R 1 Shfe, R B A A7 e R Bl B R A%

§3.4.2181TH X

Fo T A B EAR I 1 22 247, ICD2Is 4715 A :

“Run” : AHUEAT, WRISITREREPEE] T Wik e k. AT IX NS AT 772007 BLE R
SR BIFR P IS TR, IR EAR S IE L T g

“Halt” : 5 1FE1T. EER, mFICD2 S i Al Flash T 205 F (1) A 4 R Th g ok sl i
WRIHAE), AEHATICIIRER, AT CA92brE 1k T84T, 1 R AN EHAT 4T 1
DIRET o UEBan SR A T el T S80S A 5ICD2 EHL 2 (iR TG R, W 2
HFHHPAT “EES>gmRE” R

“Step Into” : FLUDHAT. Al HH DG T RE IT LU SR 2121 58 A AT ARG . FIH $5 T
RenT LASEIRZ R B 0, B, nr LU ZSh R W SR 720 S kA% 7 1), Bl F R A 22
IR BHE,

“Step Over” : BRED . i FIXANDhBER REOK Bk TR R RE, B3 AT 203
)R —iE4), XFEH P EBE] “CALL” EA) &t n LRI IXANTh G B a2 R T . |
WNHZE AR S B B AT 0 BT B AE I T RE T, IS4 FH b S 6 sl v DARE 47 [ N PR 2D BT
ST PRI A I R ()RR AL

“Reset” : i 547 X TICGmiRE T kil $ATHIhae 5 REFPCK-FE M 5 I A
bt X FCIEFERTARU, PATIEIEE)S R PCII & 48 7 main() b8 £ i Hu bk

§ 3422 W ik E

Wr s She R AE IR P &5 2RI Th g, X IShREAE S A AE IS 4T BIAH N O RE 8 A I 1
k. ERETISAT BIW S T ORI E,  FH AT DU H RRARUE IS AT 0 538 A CRAMIFIE K
SIHTIEAT I 1 o

ICD2 H REFEAIE— AN i

§ 3423 EINE

BT R R, AT R S B e AR M . O T8, ATl
— R BRI T AE A B MBI . A 3SR i A View->Watcho R T IS, BRI
S A “Wateh”  GWEASRD) EH. WK 1451718,

CC N -o
MEIEEH”ABID'ID -l Mkmhr 'r|
Aiddream | ool N | W L |
ooLr RDHCCHO o0
Cazo COTMT (=]

[wiaoh 1 wiateh 2| wach 3| wisieh 4 |
P14 B ER AR 1

FEA 1) “Add SFR” Hie4HLJS 11 ¥ T b S ey Som (R RS Bk A A7 a4 B, FP Wl AR B
S O] “ Add SFR” 2 BLKE 5 2UEE RS IR 2 A7 SN B ARt H b o [RIRERRT,
H P AT LATE “Add Symbol” 4% (f) R e i i iy 9 5 SUMIbR 5, A8 RNZ R Tk s
W B AT R &

J3 T OEEI T, P e ET AR DS B R ) “Watchl” ~ “Watchd” 447 % 15y
RIS A=
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ICD2#it T 2 M AR s Uy =0, P mT A R A dE H 7 BAT 160 e I 8240 1 DK 3 A7
e FEFAEAE S . TEAEHEAR FIEEPROMAS 63 11 o 48 FH 238001 “View” BT 0] LLFT JFEE ¢ ]
XML,

§ 3.5 YR P B i S A4

MPLAB ICD2[F iR B RESE R it £ B P BN — B R P R S o B i idix
MR R PAT EAHFE S, FHE T g iRk m 2] EAZHL. RIEAE A FHICD2 34T K,
LIS R, BRI PR T B S B D RE I PR DA & 75 8y S R W . AR AT
ST S R PR A, RIS LI 2 %5 MPLAB-IDE H I ICD2 7 B 044,

§ 3.5.1 YK T B B A6l

ICD2 [ ERATF B PR = 2 DU LA

1D M/ HRERE — N LK

2) AR D ANREM N . T AR AR B, ICD2AEAT 5D B AN BRIk 21 i A
Hkb,
3) P ATCAVS ) ek, (HEAREM 22 4L
4) MPLAB-IDEAR A2 H SBR[ IR 26 5 S BRI S LT8¢ o SER B e b - AR E 1
PG TP E Y, IDEABEIEHIIRILE

5) BRI SRRP 2 J5 BOE TS R A T BN S R AT R

§ 3.5.2 15 FL TN fe 1 Rl

ICD2f{ E I HE M PR 3 2 LR LA

1D P ANGE FISLEEPYE 4, it & Ui o i 0 FLIE AR ) 75 0

2) AR AR HWDT,

3) PR ASGETF B 5 A ARG AR ORBERE SR .

4) PRI AFETF SRR e S A

§ 3.5.3 JUPF S 7 e 2k Bl i)

PIC12F629/675. PIC16F630/676:

1) WAZ5UAd F N 5 4R 3 B A MR A TR 5 5

2) MCLRJIDAZI A i H T

3) MGPI/RALA & HL P IR TGyt 47

4) ANRELENTGPIOHEAE 84 1 3 BT A

Pl C18F XXX :

1D BCE R X An Hu bk D 200 OO HE T 46 1 BE8 AN P AT A — 4L R P B () 2 —AT
25 R R A 250 e OO EFF U BR8N FR AT — A IR AR P BRI 45 )2 o 9 ik s il ] DA A2 A
0x10, TMANREZ0x12; 45 Huhkn] LU Ox 1M ANGE /&0x14 .

2) X TPICXX20, AVDD FIAVSSH| A% |,

§ 3.5.4 fy IS B Y

MPLAB ICD2 (% FHFS 3 5 R

1D HHMCLRE I, DL AT G R P s A K i

2) 2 HEAK s

3) T EREFEIX SRAM (GFERLICD2# B e fE)

BV T 2 A S AR A 2 D (ORI BRI, AN,
5| B 3D B0 B R A B T U

FVUEAF I CD2E NS 8%

§4.1 ICD2[1)ke s ¥ &
SALLIERL
156, HPREEFS RIS CARIRSIS R RS R G EA—FERD , St
S Configure->Select Device, {EEHE0 v Y5 &l N f g f Bk £ 75 2O 5 5
BERE T AN S R 2 e PR SRR S B 5 % LY “Microchip Programmer Tool Support”
HE HLE | Microchipht 5 T HXHZS A S F s ol . o
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D Rz LR H NS A SR s fs

2) SRR % AT PSR Y i s

3) BRRIZ T H H RO S B SCREIE A AR EORAS

FEIEFES e S 2 Ja sy “OK” ik
§4.1.2 W E T HIEI

4121 kF T HEM

WERH PR SRICD2ME NS TR, AT SAEMPLAB IDEH AT WCE . sy 5 51
Programmer->Select Programmer, 1+ 4MPLAB ICD2,

XN RG R feR
Connecting to MPLAB ICD 2
ICD0019: Failed to open communications: Non—existent port
ICD0021: Unable to connect with MPLAB ICD 2ICD0021: Unable to connect with MPLAB ICD 2
MPLAB ICD 2 Ready

X J& 1 TMPLABER WA )l tH 7 20N USB, 1R IE TR A A com [, L ILATIA

MR B TE L G, REK SR ETICD2IEHAE L. WIERHEIR “ Target Device **** found”
MWA—Y)EH ;s WRHER “ICDWarn0020:Invaild target device id . .~ T84 T/ #6 A HL YR 1B LA 6
U FLAR (R 0L o

§ 4.1.2.2 ¥ G 1L T

7E “MPLAB ICD 2 Settings” % 1 FLi%4#% “Program” K ¥ B AN (Igm PN, BEE J7 ki
SR BCE AL, BCE CRUE st NI “ Y RO A

§4.123 HHKE

f£ “MPLAB ICD 2 Settings” i 1 B3¢ “Power” KB B AN EIN, LEAF A g 24 FH i
H P A Z54E “Power target circuit from MPLAB ICD2”  (JAICD2{H:HL) Fif i 1) 3% 1.

/] “Update” F258 7] LLLEH] = &1iE H Fr H st ERIVAd. Vpp A ENIER BRI S H S

Mo

WCESERE ST T N DR R R E

§4.1.24 THfEE

FH AT LLEE “MPLAB ICD 2 Settings” % 1 T fif #1585 2828 HABA < 1045 8

a) “Status” #H: WoRMEPREA, 7R H ST DIBAT AR

b) “Waming” FH: WREEGER, H AT DAEXAE H B g e B A S A 5
B

¢) “Limitation” A%H: MXHH Al LL T iR BICD2 1 — L84 H BRI

d) “Versions” F:H: WMAE B

27 “MPLABICD 2 Settings” % I FITH I H W ESEHUG, WR sl “AiE” B BeE, W
ARG S RAF I LTI E; RSt “MPLABICD 2 Settings” & 45 L5 “X” KB H
WE, BAaR “NH” KRER AR
§ 4.1.3 B H N7 ICONFIGY

YA LS A BeIE i Hb T AR H P a6 §F B W B AH N 1) CONFIG 7, s iy 3 32 51
Configure->Configuration Bits T AWV (1) ¥ &

sty “Setting” A1 HL I AR NEINZ 5 RGN < HIL—AS FRSEER, Al DIAEIX S S
LTI PEAH DY R 52

TANRAEA R AT, RN LK “Low Voltage Program” (I HL e gmfE ) EIOCH . W
RIEFITA TIXAEDL, WA SRS e &4 Rt ERESEX SIS E XL
MBS TED .

U L T T AR S P DR R, ALY ARl RETCVAIE TR
§ 4.2 F NSNS

TERHMTIRE 200, B e 2R /5 2 5 AR SO Chex ST AR N AEHT

FH 0] AT 355 B 1) File->Import iy 25K 7\ 75 258 5 [ hex XA Wi S H 7 A BN BE v
PG S, A8 ] LU 35 5% B Programmer->Read R BHARAL 2 N N AE P, 2 N2 )5 AR
SR N FH 15 5 B B CONFIG 72 Jr BT B 5
$43 K5 LA
LEE R T (www. elc—mcu. com) 16 025-51522246




A2 5 AT BT ee s, HP BVAT DS ] 258 B “ Programmer” -3 L
TR E AT A, thnr DU TR R Pt s R B A T A DGR

TR PRAE B bR A BT OO0 I S A A

Program: %505 H .

Read: U A WIS AR, AL B W 2R A & I AR,
M —E MR TS GEE2Z0) .

Verify: FEFXAS . WA HRS R CHORE, B AR R .

Erase Part: #Fx HA5.U5 o $ATHERAERI) G, HARS R R 2 58

Blank Check: 4 H bris i 285 W11

VB R e 5 A% F I IR R B 1 T S B T e S L

FNEH A E

6.1.01. ICDWarn0020:Invaild target deviceid . .

H X TR 7R B T A <

F PR IS RS R 5

SR 5 ENZRIFHEGE R

LY AE B A A 1A 5
6.1.02. ICDWarn0019: Debug modeisnot enabled. .

H I T B AR B T A <

RS BN PR S R

R IR A5 1
6.1.1 I1: AT ATKII RS Y FEER G S ?
2 FRIEES B, EISWT T TR, KAPGC. PGD FIVPP ER UL M MU, S WriiiE . e H bx
PICmicro . HLE L. 1% HFrPICmicro 5. HLATAVSS FIAVPP 51, A AKX LE5 | AR O 1E A
6.1.2 [: N AFFTEEICD Frik?
Z: XFMPLAB ICD 2 SCRFARS | IIELas A, WRAELR A5 | g R B, B AN AT 0l A X L6 2%
o AT, X8 AMGIHIMARLE, 6 MO IR LILPI AN E. ik, A5 THRM
4hE (bond-out)  PICmicro HL L, Xl EL 5 HLEEIE I — AN Sk R Al FLIX SS K 5 | B s 1F, X
{12 HELE HAR N A A 5. 4b4 (bond-out)  PICmicro 4 WA AL | 5
MPLAB ICD 2 #11. XFEMIIAR 55 7T LUHMPLAB ICD 2 JFRAGS I s 2F . Blplifg, X Fixis
WA, HATEL IR, NRENAEHARN P RA—/NCD 2 ZEHA g, A4S (bond-out)
PICmicro ¥ 5L, X244 (bond-out) PICmicro F S W2 T Eae s ), fesc B2 fhastt.
TEICD #eHek A ATk sk lie & S s LS TR RATH S ARG o IR SSA% 5 | a8 A4 T i ik
ARG RS, AR HERN ] ECE —ANCD 2 ¥R I E X se e () vep. PGC FIPGD,
KK HIMPLAB ICD 2 %ift.
6.1.3 0: LIEEREFIMPLAB ICD 2 . IRILIEIZEAM?
Z: MPLAB ICD 2 [ 22 T M5 ? IXANLED MiZ 2. Wik e thiems, wf e JUE#: T USB,
Pl e f B e — AN Y. PC [URS-232 LIARE MPLAB ICD 2 #2413, ANifUSB [af
Plo {FEATEEUSB 428 A et by . e TR R, AEMELHT). USB K3 %3k
fifing ? YEWindows ¥ 7% 5 B 2 6T HE TR NV 1% 1] LA ZIMPLAB ICD 2 [JUSB 93l —tEUSB Sk 2%
ANBEL R IIUSB B S it iy, Al F IR Se4E 2R 381, 5 Z/EMPLAB ICD 2 AN HLii,
6.1.4 []: ICD 2 Wi, “Target not in debug modeerror. ” X &4 & EH?
2 B HIXULWIMPLAB ICD 2 AREMRRPA TRl . H Al i%#Debugger>Program 3% #.,
XFF P R ) H ARPICmicros i L fE, Sk A PATRY « 0T g L e s R A3 1 X
HATFRRFAGE IR, W H AR Bhal i yg 8, &FRCEN, ifR “Background Debug” ffifE. &FE
Config>Configuration Bits..., #iffE 1R, ARASRI O, If AR5 2% % & IEH .
6.1.5 [1]: MPLAB ICD 2 RERT— MK H HIZ2 1T 11 B AR fF— i TA/E 2
Z: 2. HEHARPICmicro M A WIS FHMEKHEEIZIT, EHiEE VoD [REBL2V 15N Nigfr. £
MPLAB ICD 2 [ N/ it 22 b2 rh A7 e 44 o X S8ii N/ i g2 b sl o H brads ki
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VoD it ., 5348,  MPLAB ICD 2 A5 H ARSI TAEEE, JF IEAf A 0 T) e R A BRAR FE
PeAE, EE ] IERE A FLASH #8805 . 7/EMPLAB ICD 2 ff) “Settings” XfiEHEH, VoD F kN
“From Target” , I H1E Bt E2A —ASHIEH TR EEZEIT.

6.1.6 [1]: MPLAB ICD 2 SZ ffH{&HLEgwFE (LVP ) 15?2

2 ASCFR. HRXIFAERRY Hird e T (K VDD if, MPLABICD 2 RREIER TAE. Rk
ARIEINEIVPP G A L Y R R +12V

6.1.7 M: M AR ESAHEE (PLL ) R A4 08?2 MPLAB ICD 2 #:4E#.
2 IXJEPICmicro B HLFTER . FEXPLL #2335 AL EM nfef5, FIRTE ZW 4R 5 F izl B
PR b WREAAIXFEM, HAFRPICmicro B 5 MUK AT I 80, A 8D, BB RE T/E. [
FE, R AE DI B PLL B, A BB T Rz, B RESIEAT, (HEAE EAPLL.

6.1.8 [ MIREARNLEENS, A AFRARIIKE), BT Y IR GEAE XS KA w2 EAT,
I BRI S 0 F 5 1) T 6 SO Je AT 2

Zre XA WA DU FEAR e B KB 23R S, R GE S “Add New Hardware (73
A 7 RS EHEM)SE, %P “No, the device isn'tin the list.” , X5k “No, |
want to select the hardware from a list.” , FFi%+% “UniversalSerial Bus Controller,” . 24 H 3 “Have
Disk...” $Z41H, HENBRS) SCAFIE, IFEFRIEM IS .

6.1.9 ). FRAEME HIMPLAB ICD 2 SZHIARA R0 2

%o ANRE. ACRIERYT, FEREFE A RS AT AT DX Sk ) R SR S WIS MPLAB ICD 2 1% TAE. 4
fli FIMPLAB ICD 2 3, AN AL FATAT AR R sl R S L B B 4be s g kb AT
RIS, R EREMPLAB ICD 2, B DU REAC AR

6.1.10 ji]: MPLAB ICD 2 fuifnf &b 3 ks v £l 2

2. EHBEN . FEEEE. WMIEEFIERE, FEPEAEasH PICmicro 5 HLH TR HESE AT Ao
{H#SHEMPLAB ICD 2 it IR A7 AN BTN it S {3 Ik e H 4

6.1.11 n): A AFRMILHIEEDATA X 155 T 555 11E 2

%: MPLAB ICD 2 fig H¥Z 12N EEDATA X3, 1 ATEEHMATEECON ZFfras 2K I TABLRD 54
J¥41. MPLAB 1§ FH (W ph 8 A7 I 2 T P RS . 4B HATARRD I, 38 S /0 R 3 1 40 7
MPLAB ICD 2 $ZEEDATA X152 [a] ¢ [n 44

6.1.12 [7]:  AfF4 “Erase All Before Programming ” K45 [ ?

Zro AELEEOBTIMFLASH 250 h, g Sk B R AR A0IT (ML P A7k 85 X dk fbank 4ifs. X Tixss
oA, AEGW L FT AL SR 5 T A7 2

6.1.13 [0]:  FRIIFEFREARELE A THEMPLAB ICD 2 15 F, MPort B B4 GPIO i3
ITIEE?

B . YRR IR AET, PGC MIPGD M E#MPLABICD 2 fiif, 3 H MPORT B #4T
WS PRSI 4. 1A MPGC FIPGD 3 H E A — & IE M, T LS BX A5
HEW AW, Y356, WiiRPort B BOPAR L Wi gl i, PGC FIPGD L5 K A RE = A= i
6.1.14 []:  HUPPATHS, €A ABIT AL ?

% RSB S 2 — . BT SEps R ERPATRE P IET, EERBATRET
BATIAL, BN R b, e R Sk RIE AT

6.1.15 [1]: {E{¥FHPIC12F629/675 B{PIC16F630/676 INf, hjft A 4xfg it Fulhist 2

2 AEAH FIMPLAB ICD 2 i fiirfr, X S8 28 0- (I GPL/RAL 51 A BE 4 5 « 2 LMPLAB ICD 2 Header
(DS51292) Y, FRFFHE 2T X IX LB FHICD 2 115 8.

6.1.16 I): AT PRI AS S LED NIR?

% XA R AR EMPLAB ICD 2 ZEEAG R MELIT ) T (SEEEM R o HTINRE R H
FTHKHER, MPLABICD 2 IEAESCH] . T MRZR B H bR L2807 e T« » AR IR Power
FIBusy {5 5LED (HLJFJREHOCHT T ) o « HIT—IK “Self Test” , & “MCLR=VPP” _L[#)/Mi
W I MR REAR S IE) o o A BRSSP HURER AR EEYE R, ST — R fE. 511
(VPP) L7-8V MH T RIKT o AR, MR HFHIRLITAH %, MPLAB ICD 2 H R H S
Bl 1SRRI B . 24 B ARBOE IR LR RS, W LUE B HOE R 181k .

6.1.17 [1]: MPLAB ICD 2 " [¥] “Self Test ” A1 A1EH?

% “Self Test” #4401 B T2 MPLAB ICD 2 #beal H ArAR &2 1 ) 8. HARVDD, i %% T “Power
from ICD2” , NI HMPLAB ICD 2 $24tfJVvDD ({X5 V) . WHiEH T “Power from target” , NI
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HARRPEELIVDD (2 226V) . Pass/Fail id: #iixEK/R{EAdvanced X iEHET “Power” EANIEM, 5 H
FRpR VDD 1R 1/ KT RUE E. Bitkvep

MRATE gL A2 o EMPLAB ICD 2 #2445 HA#HVPPIMCLR 5 gfE ik (VPP) o

Pass/Fail i4: I RE Y] HARHVPPIMCLR 51 IR A IEH .

MCLR=Gnd

MAMPLAB ICD 2 A& A Hbsse rfl, $&4LH 45 HARVPP/IMCLR 51 JIf¥ A

Pass/Fail f5%: HILH K HVPPIMCLR 7|4 AN IEHfi. 00 = Pass VDD 7E#5 7 1976 H PI01 = Min error VDD
% T4& 2 K975 180 = Max error VDD 1= T-45 5 7L 00 = Pass VPP 7115 7€ K35 [l 01 = Min error VPP ik T-45
SE TG FEI80 = Max error VPP 5 148 5E {13 100 = Pass i H1SE 7] LLIR 45 H A%VPP/MCLR 5|80 = Max error
HiHSE T HARVPPIMCLR 51K &

MCLR=VDD

PRIEH T/E (41 ‘Run’ ) HI[E, MPLAB ICD 2 $2£4:VDD %5 H k5VPP/MCLR 5 JIIfE )] . Pass/Fail fi5:
AR R R W 7E Advanced XTEHES “Power” ¥E AN IERM, 28 HARMIVOD & T/ (KT E . MCLR=VPP

MARAE G 2 TMPLAB ICD 2 $24tVPP 45 HAEVPP/IMCLR SIS 17 . Pass/Fail id: HiBS %32 1

VPP/MCLR 5|2 AN 1IE A

6.1.18 |): IHIIRETFIE f84 KA H S se g by, hft4aw . STATUS FIBSR %

A E S AR ?

% T Eegoh Wi fCALL FAST (5% 1 A7 4 #MPLABICD 2 {1 T . iIX£E 2 (R 4MPLAB
ICD 2 #EM W Y8, an gL i B AECALL FAST FREFIN, sk #EMiIRETURN FAST skRETFI E
R TR At e b Wik S N, B hIn . 00 = Pass VDD A[#24E45 H bx

VPP/MCLR |01 = Min error VDD %} T H#:VPP/MCLR | K {80 = Max error VDD X T H #5VPP/MCLR
5| K700 = Pass VPP I #¢it45 H ARVPP/MCLR 514101 = Min error VPP X T H #5VPP/MCLR 7| I K A%

80 = Max error VPP %} T H #xVPP/MCLR | 1IN 5

6.1.19 [0):  YIRAEFE PRI B W E— My, hfhae sk eakooo1 , A

&M hk0000 ?

%: MPLAB ICD 2 Wi fi 5 ie4 L5, XEMWE R E T WS rhito000 4 1is 42 8T,

B U RIS, PR A S S FE M M HE0001 . 40 B FH P A AR IR B — 4 4B A b %

5, AT 20 7E HiHE0000 4bdE AN —4<NOP 154,

6.1.20 |): A ATRIIREAHifiAs o DR IE ?

% : MPLAB IDE I[F7E WoRn BRI AR(E . B W oRas i B0 sebrfE, 4204 FHIMPLAB ICD 2 4T

— IR AP

6.1.21 1) : FABPHATACHE T, FRAE N BN T, (B A4 T 5 I 2% o 7 AR 45 R %

HHAT?

& HULPATH, ELL IS A R VFPICmicro B LM N Fh K. U0 S SRVFIE, 24 A A
i, A KD PATH LT B e P IR RE P 4 o AR T, A v IR 45 R R T
FHEAT, IXFEAEF= A W7 G AT 2T A5
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